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This guide is designed to provide you with step-by-step installation instructions and best practices for Reading Plus® 3.6 for both 
LAN and WAN deployment. We recommend installing the application on a dedicated server for best performance. 

System Overview 
Reading Plus® Client Workstation - Student/Teacher workstations connect to the Reading Plus® server through a TCP/IP 
connection with their browser. Student applications and Teacher Management are cached locally the first time they connect to the 
server, so caching must be permitted to prevent unnecessary repeated downloads. Certain applications (D-Code™ and 
Visagraph™) require that signed java applets are downloaded. Users will be prompted to authorize acceptance of a signed 
certificate from Taylor Online. 

Reading Plus® Server - The server installation includes a Web Server, Application Server, and Database Server. Each client 
workstation connects through the Application Server. For best performance, we recommend that Reading Plus® is installed on a 
stand-alone server. Reading Plus® LAN products include a SQL database that is capable of serving up to 200 concurrent users. If 
a site intends to serve a larger number of concurrent users, Microsoft SQL Server must be used. 
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Installation 

Pre-Installation Tasks 
• Ensure that the server has all of the latest Microsoft patches installed. 
• Disable any firewall or anti-virus software running on the server. 
• Log into the server as a user with administrator rights to install the application properly. 
• Please note that you will need temporary disk space of approximately 1.5 GB to extract the required files for the 

installation. For the full installation, 700 MB is permanently required on your hard disk, as well as an additional 1 MB 
per 10 enrolled students (approximately). 

Network Details 
Reading Plus® uses internal IP addressing. The server and client need to be using internal IP addressing. The application will 
give users “Access Denied” errors if clients are using an external IP addresses to access the server.  

Note: In some network configurations, public addressing is used on the client and/or server machines. If you are using a public 
IP addressing configuration, please contact Taylor Associates Technical Support for assistance. 

Installation 
1. Place the CD ROM (Green disk) into the drive and wait for the installer to start. If the installer does not start, open the 

CD ROM and run the setup.exe. 
2. Click Next at the setup window. 
3. Accept the License Agreement 
4. Select the drive and path where you want to install Reading Plus®, then click Next.  
5. A file extraction process will occur, which will take some time. 
6. Select the port you want Reading Plus® to run on, click OK. 
7. You will be prompted to select a database for use with Reading Plus®. Select “Firebird” or “Remote SQL Server” as 

your database. If 200 or fewer concurrent users will be using Reading Plus®, then you can select Firebird as your data-
base. Sites that plan to serve more than 200 concurrent users will require Microsoft SQL 2000 (Standard Edition-
Processor License) or Microsoft SQL Server 2005 Workgroup or Standard Edition, which must be purchased and 
installed separately. 

8. If the Firebird database option was selected, Firebird will be installed. 
9. When prompted, insert the Blue License CD.
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Database Installation  

Remote Microsoft SQL Server Installation 
If you chose Firebird as a database server please skip to 7. 

1. In order to attach the Reading Plus® database to a remote SQL Server, you are required to have Administrator access 
rights on the remote SQL Server. This is only for the remote database installation. 

2. You will be prompted for the Server Name, Instance Name (leave blank if default instance), database port, username 
and password of the database. Use a database system admin account (SA, [password]). 

3. Test the Server/Instance/Port using the Test button. After the test is completed, press OK to return to the Main attach 
screen. 

4. Press Continue: If you do not have administrator rights, you will be presented with the following error message:  
“Could not communicate with remote host on that port.” 

5. If you do have rights on the remote server, you will be asked to pick the drive where the database will reside on that 
server. The application installs the database to the path /TaylorOnlineDB/data_files/ on the selected drive.

6. The database should be attached on the remote SQL database server. The application will be configured to use that 
remote SQL Server instance. 

7. Once attached, click OK. You will be prompted to place the License CD in the drive. When the License CD is found 
and applied, installation is complete. 

 

Installation Completion 
Upon completion, the installation may require a server restart. If a restart is requested, please do so to ensure that services start 
correctly.  

An icon will be created on the desktop. This icon points to the installed application, and is labeled “Reading Plus.”  

You can login either from the server (icon) or go to any client workstation and login to:  
http://[netbios_name]/readingplus  (for example: http://myserver/readingplus).   

If you have problems determining the server name of your Reading Plus® installation, double click the icon that was created on 
the desktop.  This should open the browser to the location of the Reading Plus® application.  Look at the address located on the 
top of the screen after the http://.  This should contain the server’s name. 

Note: The server should not be used as a client machine for any other purpose than testing the validity of the installation. 

 

http://myserver/readingplus
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Services, Tools and Utilities 

Service Installation Details 
The web server (Apache), application server (Tomcat), and database (LAN only) are installed as services on the local machine.  
The web server uses port 80 as default port. If another program is using port 80, choose a different port to run Reading Plus®. 
These services can be monitored through the Reading Plus® Network Monitor tool. The Reading Plus® Network Monitor tools 
monitor the specific services used by Reading Plus® and these services can be stopped/started/restarted using this tool.  

Reading Plus® Server Tools/Utilities 

Reading Plus® Monitor 
An icon will be placed at the lower right corner of your screen in the system tray (the icon looks like a book).  

 

 This application will allow you to monitor services, deploy icons, and set up notifications. Single click the icon (book) and you 
will be presented with the following: 

 

If the Apache Web Server, Tomcat Application Server, and Firebird Server all have checkmarks and are labeled in green, all of 
the required services are up and running.

Any label designated Click to Stop can be used to start and stop services. If any of the required services are not running, the label 
will turn red and the text will change to Click to Start. 

Change Web Server Port: Allows the admin to change the Apache web server port from port 80 to another port.  

Deploy to Network Workstations: Allows the admin to deploy workstation icons to user desktops on the network, with failures 
and successes, based on access to the user’s machine. For every computer listed in the Deploy List, an icon will be created on the 
user’s desktop, pointing to the server installation.
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• Computer names are selected from the Available Pool list by single clicking on the computer name (PC only).  
• The computers are then listed in the Deploy List.  
• Click on Deploy to add the icon to the computers listed in the Deploy List.  
• If an icon cannot be created on the user’s desktop, the computer name will be listed on the Deploy Fail list.  
• If the creation was successful, the computer name will be listed in the Deploy Success list.  
• To remove computer names from the Deploy List, single click on the computer names in the Deploy List.  

Note : This program was meant to deploy on Windows workstations only, not Macintosh workstations. 

 

Administrator Failure Alert Settings: Allows the admin to set failure/notification messages to be broadcast to a certain 
computer on the network. If services fail, the computer names listed on the Failure Notification list will receive broadcast 
messages. This is useful for administrators, since they will be able to respond to issues before a user calls. 

 

Computers are selected from the Available Pool list to receive notifications. To remove computers, single-click on the computer 
name in the Failure Notification list. 
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Database Backup 
The backup program will back up your Firebird database. (This utility cannot be used for Microsoft SQL databases.)   

We strongly encourage you to use this backup utility or to include the Reading Plus® database in your backup strategy. Reading 
Plus® can be recovered very easily from the database backup. 

Click on the option in your Reading Plus® Online Monitor called Automated Database Backup. When the window opens, click 
on the Settings/Setup button. 

The defaults will backup the Firebird database nightly to C:\TaylorOnline\Reading Plus.  You should never need to change the 
username/password on the database.  This is included if a site does change the database defaults. 

UnInstaller 
• To uninstall Reading Plus® click on:  
• Start > Programs > ReadingPlus > Uninstall Reading Plus Network 
• If you have chosen to uninstall Reading Plus®, please reboot your server after the uninstaller has completed. 
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Server Tips 
Windows Firewall 
We recommend you disable any software firewalls running on the server.  Reading Plus® LAN/WAN can be run only from 
within the network. Running software firewalls could be detrimental to performance issues.  

Note: Microsoft Windows XP (SP2) installs and enables the Windows Firewall by default.  

Anti-Virus Software 
Disable any anti-virus software on the Reading Plus® server.  Reading Plus® is composed of thousands of files, and enabling a 
virus scan on the server could lead to performance issues.  If you do plan on using a virus checker on the server, try to configure 
the software to ignore the Java Cache directory.  If the virus checker is enabled on the Java Cache directory, the first time 
someone accesses the application it will be scanned.   

Proxy Servers 
If the proxy server caches jar files, this proxy cache will need to be “flushed” periodically to allow for Reading Plus® updates.   
This has to be flushed during update periods.  If possible, remove www.readingplus.com from your proxy server. 

Filtering and caching servers 
Take care when filtering and caching data that the address range for Reading Plus® is not in you filtering and caching servers.  
The IP range for Reading Plus® servers in the range: 167.206.143.130 - 167.206.143.190 

Patching and updating utilities 
If you are using a network patching and updating solution such as Sophos, try to schedule updates during non-class times.  
Windows updates and patches can adversely affect the application’s performance. 

Specific Operating System Issues 
 
Microsoft Windows 2003 Server enables a security level that will block incoming client requests. 

1. Open Internet Explorer and click Tools > Internet Options. Select the Security Tab and change the security level for the 
Internet zone to Medium and click OK.

http://www.readingplus.com/
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Workstation Tips 
The following information will help you configure your workstations to run Reading Plus® properly and efficiently. 

Hardware Requirements 
Please make sure your workstations meet the requirements listed in the Reading Plus® Technical Documentation Manual..  
Reading Plus® requires Windows 2000, XP, Vista, or Mac OSX (10.3.9 or higher) for the operating system. The hardware must 
be a 500 MHz, with 256MB RAM as a minimum.   

Software Requirements 
The Reading Plus® applications are java applets that require Java Plug-in 1.5.0_10 as a minimum requirement.  This can be 
downloaded from http://java.com and will be checked on login. 
 
The applications use Flash movies as motivation tools and instructional media.  The application requires Flash Plug-in 8. This 
can be downloaded from:  http://www.adobe.com/ (click on “Get Adobe Flash Player”). 

Caching 
In order to ensure that students, teachers, or administrators are not repeatedly downloading the Reading Plus® applets to the local 
workstations, you must be sure that these files are cached on the local workstation. Reading Plus® applets are stored in the Java 
Plug-in Cache (Sun VM) which is assessable through Start > Settings > Control Panel > Java Plug-in.  

NOTE: If you are running security software such as Deep Freeze or Fortres, the network administrator needs to ensure that the 
Reading Plus® JAR files (Sun VM) are not cleared. 

Cookies 
Ensure that all student workstations are set to accept cookies. This will prevent students from having to enter the site code 
repeatedly. 

Pop-Up Windows 
Management Help files, along with the Reports and Print Preview pages contained within them, may be blocked if you are using 
a pop-up blocker utility. Please disable all workstation browser pop-up blockers.  If this is not possible, pop-ups can be displayed 
temporarily by holding down “control” when clicking the Reports or Print Preview pages.  

Print Set-Up 
1. Go to Tools > Internet Option > Advanced tab and scroll down to Printing. Make sure the box labeled Print background colors 
and images is selected.  

2. Go to File > Page Set Up and make sure your page is set to print in Landscape mode. 

 

http://java.com/
http://www.adobe.com/
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Microsoft Windows Profiles  
How does Windows profiles and Java caching impact Reading Plus®?  
Reading Plus® online is a browser-based application comprised of multiple java applets (jar files) that are run through the client 
browser’s java virtual machine (JRE). The applets are delivered on demand, based on client request. After the applets have been 
downloaded to the client, all subsequent requests for the applets from a particular client are pulled from the local cache on that 
computer. These applets average 1MB and the initial downloads contains roughly 3.5MB of applets and resources. 

The applications need to be downloaded only once per workstation.  If the workstations have to download these applets 
repeatedly, students may experience longer load times.   

Profile Types 
There are two types of Windows profiles, local and roaming (default for most users).  

Local Profiles  

Local user profiles are settings and configurations that are saved on a particular machine and do not follow a user as he 
or she moves from location to location.  Each network location will have a different set of user settings and 
configurations. 

If Local Profiles are used, the java cache directory will exist for all users that use a particular workstation. These local 
profile java cache directories will not travel with the users from workstation to workstation.  This will require 
unnecessary downloads and extra copies of Reading Plus® applets on the workstation. 

Roaming Profiles  

Roaming user profiles are simply collections of settings and configurations that are stored on a network location for 
each user. Once you perform some simple configurations, every time a user logs on to a machine in your domain with 
his or her domain credentials, that user's settings will follow him or her. The settings will be applied automatically to 
the user’s log-on session for that particular machine. 

If Roaming Profiles are used, the java cache directory points to a local user directory for the java cache on the 
workstation.  This cache directory does not get updated on the Roaming Profile.  This means every time a user logs into 
any workstation (even the same one twice in a row) he or she will need to download the java applets.  This will require 
unnecessary Reading Plus® applet downloads. 

How to configure Windows Profiles effectively for Reading Plus® Instruction: 
Solutions for Local Profiles 

There are two straightforward implementation solutions to help minimize issues with Reading Plus®: 

Approach #1:  Assign workstations to students 
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• Assign a particular workstation to a student.  If the student logs in to the same workstation every day, he or 
she will only have to download the applets once, on that particular computer. 

Approach #2:  Assign a login to a particular computer 

• Implement a login that is assigned to the workstation.  If the lab is configured so that each workstation has its 
own network login (and not each user, ex: login: computer1, password: computer1), there will be one profile 
per machine. The java cache will remain with every student login, as long as the student logs in with the 
workstation username and password. 

Solutions for Roaming Profiles 

Networks that use Roaming Profiles configure their network to run Reading Plus® efficiently by implementing a 
technical solution to the user’s profiles. 

Technical Solution:  

Within each user’s profile there is a default Java cache directory.  By changing this directory to point to a non-local 
user directory, it will not be updated by the Roaming Profile.  This will allow the Reading Plus® applets to be 
downloaded once per workstation and shared for all users on that workstation.   

Example: The default location for the java cache directory is: C:\Documents and Settings\[User]\Application 
Data\Sun\Java\Deployment 

If this is changed to : C:\JavaCache\, it will not be updated by the Roaming Profile and applets will be pulled and 
shared from this location.  (See “Changing Java’s Default Cache” below.) 

Care should be taken that this directory is local to the workstation and not across the network.  If a shared network 
resource is used, this could create internal bandwidth issues.  Every user will be pulling Reading Plus® applets from 
the same directory. 

Changing Java’s Default Cache 
Note: this is for individual configuration, for global configuration, please contact Taylor Associates support. 
Link from Sun : http://java.sun.com/j2se/1.5.0/docs/guide/deployment/deployment-guide/properties.html 

Located in the users profile directory is a file called deployment.properties.  
<User Application Data Folder>\Sun\Java\Deployment\deployment.properties 

• This is a text file.  Open the file in a text editor. 
• Locate the entry labeled: deployment.user.cachedir 
• NOTE: This entry may not exist.  If the entry is not found in deployment.properties, add the entry to the file: 
• deployment.user.cachedir= 
• Change that directory to a non-user level cache directory (Example: C:\JavaCache\  
• Save the file. 
• This must be repeated or copied for all users. 
• The Reading Plus® Support Team is developing an application to script the cache changes to help expiate 

this process.   
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Effective use of Deep Freeze  
 
It is essential to permit caching to prevent unnecessary repeated downloads and maximize network efficiency. The 
applications need to be downloaded only once to each workstation. Initial download size of the applications is 
approximately 3-8MB per workstation. If the workstations have to download these applets repeatedly, students may 
experience prolonged loading time, which wastes valuable instruction time. 
 
Configuring Deep Freeze to cache applets: 
To ensure that your network running Deep Freeze is set up to allow for caching, follow these instructions: 
 

1. Create a Thaw Space on the client machines. Please refer to your Deep Freeze user guide for this step. 
2. Open Deep Freeze, and Boot Thaw the drive for 1 reboot. 
3. Reboot the machine so Deep Freeze is disabled. 
4. Make sure you are logged into the computer as a Local Administrator.  
5. Open the Control Panel. 
6. Look for the Java icon and double click it. 
7. Under the General tab look for the Settings tab under Temporary Internet Files and click it. 
8. Under Location, select a location on the drive that you want the Java cache to be stored. (You have to change this, or a 

file you need. You can select c:\windows\temp.)  
9. Open My Computer and look in C:\Documents and Settings\administrator\Application Data\Sun\Java\Deployment. 
10. Look for a file called deployment.properties. 
11. If deployment.properties is in the folder, return to C:\Documents and Settings\administrator\Application Data folder.  
12. Copy the Sun folder. 
13. Back out of that folder so you are in the C:\Documents and Settings folder. 
14. Open C:\Documents and Settings\All Users\Application Data, and paste the Sun folder into the Application Data 

folder.  
15. Open C:\Documents and Settings\Default User\Application Data, and paste the Sun folder into the Application Data 

folder.  
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Effective use of Fortres 
 
It is essential for caching to be permitted to prevent unnecessary repeated downloads and maximize 
network efficiency. The applications need only be downloaded once to each workstation. Initial download 
size of the applications is approximately 3-8MB per workstation. If the workstations have to download 
these applets repeatedly, the students may experience prolonged loading time that wastes valuable 
instruction time. 
 

Configuring Deep Freeze to cache applets: 
1. Load up Fortres 101. 
2. Select the File and Registry setting. 
3. Select the No Restrictions option in the right window by double clicking it.  
4. Right click in the window and click and select Insert Item. 
5. Click on the Browse button. 
6. Browse to where Java is installed, and select this folder by clicking Open.  
7. Click OK and close Fortres 101 
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